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Highlighting Text to Make Changes

To make formatting changes to text (i.e. bold, line spacing) you can either highlight just a
word or group of words. Or select all text in the placeholder by clicking twice on the box
that surrounds the text so that it gets the sizing handles.

Changing Fonts and Sizes

Highlight the text you want to change.

Click Format on the menu bar

Choose Font

Make your desired selections

Click OK Change font types

Change font styles
Change font size

Change font color
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Aligning Text
Select the text you wish to align
Click the alignment button(s) on the toolbar

OR

Select the text you wish to align
Click Format from the menu bar
Click Alignment

Click the alignment style you want

To Add More Text to a Slide
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Click on the text box-icon in the drawing toolbar.

Left mouse click or draw a box with your left mouse on the slide where you want to insert the
text.
Start typing.

To Change Line Spacing on a Slide

Click on the placeholder of the text you want to change.
On the Menu bar, select Format, slide down and select Line Spacing.
Make your choices and click OK.
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Modifying a Bullet
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Recoloring Clip Art

Click on the Recolor Clipart icon on the picture toolbar.
Make your changes in this window.

Creating an Organizational Chart

To Add an Organizational Chart

1. Select slide layout that includes an Organizational Chart.
2. Double click on the Add Organizational Chart placeholder.
3. Select placeholder to enter text.
4. Type all appropriate information in the box and press Enter.
5. Repeat process until all desired boxes are filled.
6. Click on File on the Menu Bar.
7. Pull down to Exit and Return to Presentation.
Or.. Select
MS Organizational
1. Open the Insert menu
2. Choose Object
3. Select MS Organizational Chart 2.0 from the Object Type
list
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Use this
toolbar to add

Adding New People to Your Chart
new people to
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If it is not already open,
Double Click the Chart to open the organizational chart dialog

box
Click the toolbar button to add the type of position pt ﬁ e 8

you want to add to the chart
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Click the placeholder for the person related to the new
position you are adding to the chart 4
A placeholder appears for the new position e / -
Enter the name and title for the new person Use the
placeholders
Deleting a Person from a Chart to begin
entering
1. Click on the position you want to delete people onto

2. Open the Edit menu
3. Choose Cut or press the delete key

Moving People in a Chart

Click on the position you want to move

Drag the position and place it on the placeholder to whom the person reports
Release the mouse when the position is in its new location

Press the Esc key to deselect the position
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Inserting a Word Table Microsoft Word

Table Icon
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While in Slide View:

1. Click the Insert Microsoft Word Table icon from the
Standard toolbar

2. Click and drag over the grid to define your table

3. Release the mouse a table grid appears on-screen

4. Notice as you are working in the table your toolbars are the Word toolbars, when you
click out of the table your toolbars go back to the PowerPoint toolbars. You can format
the table as you would any table in Word. Keep in mind that you don’t want to decrease
the font too much otherwise people will not be able to see the information.

5. Enter titles for the columns, pressing Tab after each one to advance to the next cell

6. You can highlight the table to make borders similar to how you would make them in
Word.

7. You can adjust cell size by using either the horizontal or vertical rulers.
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While in Slide View:




Click the Insert Microsoft Excel-Worksteeticom fronrthe®tandard toolbar

Click and drag over the grid to define your table

Release the mouse a table grid appears on-screen

Notice as you are working in the spreadsheet your toolbars are the Excel toolbars, when
you click out of the spreadsheet your toolbars go back to the PowerPoint toolbars. You
can format the spreadsheet as you would any spreadsheet in Word. Keep in mind that you
don’t want to decrease the font too much otherwise people will not be able to see the
information.

5. Enter information that you want included in your spreadsheet.
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Adding a Chart Change the format of
your graph using the

buttons on the tool

In the Slide VieW, e —

Open the slide on which you want to insert the chart e R T [ e L]

Click the Insert Graph button on Standard toolbar
The data grid opens default data

Notice how the toolbars change to Charting icons

Delete the default data

Enter the information you want charted on your slide
Tab will move you across the data sheet cell-to-cell
Enter will move you down the data sheet cell-to-cell

After entering all of your data Click the View Data

Sheet button

You can make changes to your graph in the graphing

toolbar

Press Esc twice to return to the slide
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Inserting a WordArt Object

In the Slide View,
Click on the WordArt Icon on the drawing toolbar
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Select a WordArt Style

Enter text in the Enter Text Here dialog box then Click OK

Move the WordArt to where you want it to go

Make any other changes to the WordArt using the WordArt toolbar that appears

Same
WordArt WordArt  Letter

Gallery Sh:s‘)e Heights Alignment
AN . /



Inserting Pictures

You can insert pictures from a digital camera, scanner, the Internet, or a clip art gallery into
your PowerPoint presentation.

Go to Insert and click on Picture and pull to From File.

Change to the location you saved it from above (i.e. desktop, my documents or a folder you
created).

Click on the picture.
Click Insert.
Now you can move it around and change the size.

To change features of the picture, click on the picture and the picture toolbar should appear
(Note: If the toolbar does not appear, Right click on the picture and left click on Show
picture toolbar).
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InsertPicture More Cofitras! Mor¢ Brightness \Crop Tool Recolor Pict Set Transparent_ Color

Image Control Less Contrast Less Brightness ~ Line\Style Format Picture Reset Picture
Copying an image from the Internet for your presentation
1. First of all make sure the image is not copyright protected.
Have your mouse cursor on top of the image you want to copy.
Right mouse click on the image and select Save Image As with your left mouse button.
In the Save As Window, select the folder or disk where you want to save the image.
Give the image a new filename if you want, then click Save.
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Inserting Sound Clips to a Presentation

Go to the Insert Menu Bar.

Click on Movies and Sounds and pull to Sound from File

In the Insert Sound window, navigate to the folder with the sound clip.
Double click on the desired sound clip file.
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Inserting Movie Clips to a Presentation

5. Go to the Insert Menu Bar.
6. Click on Movies and Sounds and pull to Movie from File



1. Inthe Insert Movie window, navigate to the folder with the movie clip.

2. Double click on the desired movie file.

If you can’t see the movie files in the folder type in *.mpg (or the extension of the movie, it
might be *.avi also) where it asks for the filename.

Inserting a Custom Background to a Presentation

1. Inthe slide view, click on Format on the Menu Bar, and slide down to and select

Background.

Click on the down arrow in the middle of the window, and Fill Effects.

Click on the Picture Tab.

Click on Select Picture.

Navigate to the folder with the picture file.

Double click on the desired picture file.

Click OK.

Back in the Background window, click on Omit background graphics to master to place a

check in the box.

9. Select Apply (to apply to one slide) or select Apply to All (to apply to all slides in the
presentation).
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To Apply Slide Transition and
Text Effects
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1. Go to Slide Sorter View. R —

2. Be on the slide where you

3. Clickon Tran

sound.

6. Click Apply . aii=s ! rorers =

To Apply a Text or Object Animation

1. From Slide Sorter View, double click on the slide you wish to work with. This will take
you to slide view.
2. Click on the text or object to be animated.
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3. On the Menu Bar select Slide Show, slide down and Preset Animation and pull to the
desired animation (drive-in, flying, camera, etc.). Or select the desired preset animation
on the Animation Effects Toolbar.

Custom Animation Settings

Allow you to change the order of your animations, timings, the effects, chart effects or the
play settings.

Select Slide Show from the Menu bar, slide down and select custom animation. Click on
the various tabs to make your changes.

Interactive Settings
Interactive settings let you build interactions into your slides that will take you to other slides
or allow you to run a program by clicking on the icon (text) during a presentation.

Branching to Another Slide or Embedded Program

Allows you to create branches in your presentation to another slide or another embedded
presentation (maybe has different slide orientation). When you branch to a presentation you
automatically return to the original presentation; when you branch within a presentation you
can you Slide Navigator or create another button to return to the first slide.

Set up a branch to another slide or Web Page

1. Go to Slide Show and pull to Action buttons. I

2. Select the butto T B wndow sk

3. Draw the shape of the button on your slide, when youTe
go of the button, the Action Settings window will appear. Record faration, .

4. Select Hyperlink To, then select the slide you want to B
branch to on the drop down list: you can also select =
another PowerPoint Presentation or URL (type the entire '.‘.'Jm
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To return to the first slide create a button on the branch slide
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Set up a branch to a Program

You can also branch to another program like Word or a specific page | REREG_G_G_G_____—_E—E—E—N

on the Internet to use while in your presentation. Shje Show Wndesn Helo
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1. Go to Slide Show and pull to Action buttons. ?m:;:: o
2. Select the button. 3ot Up Show..

3. Draw the shape of the button on your of e

the button, the Action Settings window will appear
4. Select Run Program, then click on Browse.
Navigate to Find the program. Double Click on the program.
6. Click OK.
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Pack and Go

Saving Power Point Presentations that are too large to copy directly on a disk

To Save a Presentation to Floppy Disks

APwbhPE

Open the presentation you want to save to disks.
On the Menu Bar, go to File, select Pack and Go.
Follow the directions in the Wizard.

It will ask you to insert another disk when needed.

Opening a Pack and Go Presentation
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Put floppy disk one of your presentation in the floppy drive.

Double click on the My Computer icon on the desktop.

Double click on the 3% floppy disk icon.

Double click on the Pngsetup.exe file.

Select the location you want to extract the file (you may want to create a folder prior
to doing this)

Once it is done it will ask you if you want to run the presentation now. If you do not
you can later go to the folder where you extracted the presentation to and open the
presentation like you normally would.

Last modified 7/12/00



	HIGHLIGHTING TEXT TO MAKE CHANGES	2
	Changing Fonts and Sizes
	Aligning Text
	To Add More Text to a Slide
	To Change Line Spacing on a Slide
	Modifying a Bullet
	Recoloring Clip Art
	Creating an Organizational Chart
	
	
	
	To Add an Organizational Chart



	Adding New People to Your Chart
	Deleting a Person from a Chart
	Moving People in a Chart

	Inserting a Word Table
	Inserting an Excel Spreadsheet
	Adding a Chart
	Inserting a WordArt Object
	Inserting Pictures
	Copying an image from the Internet for your presentation

	Inserting Sound Clips to a Presentation
	Inserting Movie Clips to a Presentation
	Inserting a Custom Background to a Presentation
	To Apply Slide Transition and Text Effects
	To Apply a Text or Object Animation
	Custom Animation Settings
	Interactive Settings
	Branching to Another Slide or Embedded Program
	Set up a branch to another slide or Web Page
	Set up a branch to a Program

	Pack and Go
	To Save a Presentation to Floppy Disks
	Opening a Pack and Go Presentation


